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Some questions

Who is a MS Project user?
Who has followed MS Project courses?
Who has followed Open SE courses?

Who needs planning and scheduling to do
their job?
Who uses already JIRA?

Who uses a tool for planning and scheduling
different from MS Project/JIRA?

Which one?




Some words about JIRA




JIRA Introduction

« What is JIRA?

« Gojira - Japanese word for Godzilla

« Issue Tracking and Project Management

« Developed by Atlassian

« CERN runs JIRA 8.0.2 in https://its.cern.ch

« Three products
JIRA Core
JIRA Software
JIRA Service Desk

« CERN has unlimited number of licenses for JIRA
Software Licenses that contains JIRA Core



https://its.cern.ch/

WBS Gantt-Chart plugin

What is Gantt-Chart plugin?

Third Party tool developed by Ricksoft
It provides visual project planning through Gantt charts
Some interesting functionality
Task dependencies with drag-and-drop interface
Modify schedules and dependent issues update automatically
Smart workload allocation with resource monitoring
Critical path
Baseline plan
CERN has now unlimited number of licenses for this
plugin
CERN runs now version 9.9




JIRA Basics

- JIRA ISsSues

« JIRA building blocks

« They could represent a story, a bug, a task, or
another issue type in your project
« For planning and scheduling
- We will use them as tasks
Issues = Tasks or sub-tasks from now on
- Tasks and sub-tasks are treated in the same way




Planning and scheduling tips
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Project Master Schedule

Starting point before defining the
coordination schedule (Gantt Chart)

The master schedule is a summary
It should be intuitive
It should contain the whole project overview

Starting from the main phases of the master
schedule, the remaining tasks can be
defined




WBS Gantt-Chart




[PROJECTALT-22] Pre-procurer X [PROJECTALT-22] Pre-procur

C re a_te a_ J I R A < ¢ @ oF httpgk

GIT ¥ Jenkins ¥ JIRA ¥ SVN v

P =
rOJ e Ct Home page / JIRA Project Request

Request a JIRA Repository
https://cernforge.web.cern.ch/jira

@ Your project will be created on https://its.cern.ch/jira.
JIRA ¥ SVN v

ACTIONS
Froject leader Maria Alandes Pradillo (malandes)

Create new project Can be changed later in JIRA

List my projects Mame* | Maria Gantt 1

List all projects
proJ {Ey* MARIAGANTT1 (:'?_}

Map/Sync e-group

This is the unique project key.

Sync project . .
Project Template Proiect management ¥
LINKED REPOSITORIES

Link repository Notification Scheme | Default Notification Scheme N
Show linked TEPOSItOI'IES Worlkflow Scheme CERN default workflow scheme -
SUPPORT

Issue Type Scre@d manaaement issue tvoe SCID
Service Scheme
FAQ Category | _____ E
Permission Schemes SeleCt Permission Scheme Default Permission Scheme .
Notification Schemes Advanced to see

Categories all the options pasi

Issue Security Schemes



https://cernforge.web.cern.ch/jira

Project Template

Project management

- Projects should be
The project management project offers a slightly more robust workflow, allowing you to work on
- . bigger items by offering a workflow that has an In Progress status. This allows you to start work on a

C re ate Wlt . task, and keep working in it until it's complete. Track your work in JIRA Core by using ur built in
reporting, your dashboard, and custom filters based on your searches.

- Project

r ] To Do = In Progress > Done
Management

Workflow

template B - (weeecress’ — &3
« More information T and sub-tsc A sub-tk st belong 0. pret a5k

ISSUE TYPES

about project
Sub-task
n
templates:
Summary, lssue type, Reporter, Attachment, Due Date, Original Estimate,

https //Cern . SerV|Ce- ssue fields Remaining Estimate, Description, Assignee, Priority, Resolution and Labels
nOW. CO mlserVICe' Resolutions  Done, Won't Do, Duplicate and Cannot Reproduce
portal/article.do?n=KB0005975

Priorities Highest, High, Medium, Low and Lowest



https://cern.service-now.com/service-portal/article.do?n=KB0005975

Who will be notified in your project

- Projects are created with:
« Default notification scheme

- You can change this in:
https.//cernforge.web.cern.ch/jira/myprojects/

- For more details on notification schemes:
https://cernforge.web.cern.ch/jira/notificationschemes/



https://cernforge.web.cern.ch/jira/myprojects/
https://cernforge.web.cern.ch/jira/notificationschemes/

Task workflow

- Projects are created by default with the
workflow defined in the Project Template

-  However, the workflow can be reconfigured

« For more information please check:
https://cern.service-now.com/service-portal/article.do?n=KB0002999

- Learn more also about board workflows

https://cern.service-now.com/service-portal/article.do?n=KB0001729

You can create your own workflow in the board configuration by
adding status and columns



https://cern.service-now.com/service-portal/article.do?n=KB0002999
https://cern.service-now.com/service-portal/article.do?n=KB0001729

To display Gantt Chart fields

- Projects should be created with:

« Project management issue type screen scheme

- This allows to display Gantt Chart fields in the JIRA
task

- This screen type Is available for all project
templates

« Not only for Project Management template!

- For existing projects

« Open a SNOW ticket requesting this type of
screen to be activated for your project




Who can watch your Gantt

- Projects are created with:

« Default Permission Scheme

- This means the project is only visible to project
members

- The same for the Gantt Chart
- You can change this in:
https.//cernforge.web.cern.ch/jira/myprojects/

- For more detalls on permission schemes:
https://cernforge.web.cern.ch/jira/permissionschemes/0/



https://cernforge.web.cern.ch/jira/myprojects/
https://cernforge.web.cern.ch/jira/permissionschemes/0/

Create a Gantt Chart

[ssues v

Boards v

WBS Gantt-Chart ¥ CERNforge ¥

CURRENT GANTT
MS Project Alternatives
RECENT GANTTS

HTCondor
CC Racks replacement
LS2 P8 Atlas project

e Create Gantt

View all Gantts

Online document

Create a new Gantt...

Create from project Create from filter

=z

Create Gantt from project

Gantt name | GANTT example

Project Gantt Test 1 % ‘ M

Create a filter from the specified project group and display WBS Gantt-Chart
using this filter.
Warning:
Please avoid managing a single issue in multiple Gantts because it may cause unexpected
behavior.

The default setting prepared by WBS Gantt-Chart for Jira is given as the initial setting of
the created Gantt.

Create  Cancel




d d I a.S kS Edit the values directly here

or in the JIRA classic view

@ Gantt: GANTT example o -
© Add ©Deleter #Editv ©Vieww T Data~w Today « » Month~ Save
) 2018
# © | Project/Version / Issue Assignee Units Priority Start date T Finish date Durati... | Perce..
ECEP‘\B Jan 2019 Feb 2019 Mar 2019 Apr 2019
1 ~ @ Gantt Test 1 0% '
1-1 (1] » Evaluation Phase MariaAl..  100%  Minor 17/Dec/18 18/Jan/19 25 days 0% hase == Maria Alandes Pradillo

-+ Task Name
n Bug . ASS|gnee Evaluation Phase

# Eplc # Edit  QComment Assign More ¥  ToDo InProgress Workflow v <<y Export ¥

'r ¢ % Of tl m e ~ Details v People
Type: Task U
+ New Feature al I O C ate d tO Status: (View Workflow) e

Maria Alandes Pradillo

the task s e
Resolution: Unresolved Reporter:

Labels: None Maria Alandes Pradillo

E Sub-task ° Start and Votes:

v Description 0

Version F i n i S h d ate O r Click to add description Watchers:
= @ stop watching this issue
Copy D u ratl O n v Attachments
v Dates

lssue o P e rce n tag e (% Drop files to attach, or browse. Created:

15 minutes ago

Issue and all child issues CO m p I eted > Sub-Tasks + - Updated:

11 minutes ago

v Activity

Al Comments WorkLog History Activity v Agile
View on Board

Subversion

There are no comments yet on this issue.



Gantt Chart

Gantt Chart Fields  reatedfieus

Edit Issue : PROJECTALT-35 { Configure Fields ~

- Note that Gantt Chart
flelds are visible in the
task only if the project :
was created with the oueoe
right screen template  ~ T —

® The f|e|dS are Start date | 20/Nov/18

(WBSGantt)

displayed in the task
SC re e n O n Iy if th ey e Finich date in WES Gantt-Chart
Baseline start date

h ave S O m e Va-I u e : e Baseline start date in WBS Gantt-Chart

« Edit the task

Baseline finish date in WBS Gantt-Chart

° CheCk the Gantt tab Units (WBSGantt) |0
« Fillinthe fields  «« e [




Task depencies

- The easlest Is to drag and drop directly in
the Gantt chart to create task dependencies
- Startto End
« Endto Start
- Start to Start
« Endto End

- In the Edit Menu you can also
« Indent/Outdent to modify the task hierarchy
Move up or down to reorganise the task order




About Task bars

- Colours
« Parent bars: blue
« Children bars: green
« Completed issues: light blue or green
« Baselines (see later): light grey bar

- Task Names

« They appear on the left

- Feature request to allow to drag and drop:
WGC-856




Milestones

- Create first a Task
« Then convert to Milestone from Edit Menu

SET BASELINE
Issue
! Issue and all child issues
| All C d 155UeS
Indent
Qutdent
|

I Moveup
|

|
1 Move down

Renumber WBS code (#)

&)

N/



Add Users

JIRA ADMINISTRATION

Projects G -
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Add Users

Project settings

Summary Users and roles Add users to a role ) Edit defaults

Details
Defaults
Add users to a role

Issue types Project Lead Maria Alandes Pradillo Default Assignee Project Lead

Bug Users by role Users or groups
Epic |Sea|c*. by name or email
Roles: All = Q Search by name or email
Improvement
Role
New Feature
Administrators ~ Showing 1 of 1 Administrators
Sub-task
Task Name Username Email address
Maria Alandes Pradillo malandes maria.alandes.
Workflows
Screens Developers Showing 1 of 1
Fields Name Username Email address Last session
Priorities . . i . .
Maria Alandes Pradillo malandes maria.alandes.pradillo@cern.ch 54 minutes ago

» Add users to Developers role (permissions to modify issues)

* Note that Users role are users who can create issues. Maybe this is not what
you want if using JIRA for project management

» Note that you can change the permissions of each user type anyway

« Be aware that CERN users need to have logged in at least once in JIRA to be
able to see them as JIRA users!




Adding users through e-groups

- You can add all the users of an e-group by
adding the e-group to a role

« But please, note that tasks can only be assigned
to a single user

- If your e-group Is not recognised by JIRA

- Goto
https://cernforge.web.cern.ch/jira/egroup/sync/

« Add the e-group
You should now be able to see it in JIRA



https://cernforge.web.cern.ch/jira/egroup/sync/

Dummy Users

-  Dummy users may be needed for your
project
« For short term tasks

 To calculate needed resources and estimate
effort

- In order to create dummy users:
- Create a service account
« Log in once in JIRA with the new account
« You can now assign that account to your project




Resource View

oo @ B | R search v @

<« c @ ® @ httpsy/its.cem.ch/jira/secure/WBSGan!
@ Getting Started @ Diccionario de 1a leng... @ RAL-LCG2 FTS3

© Add O e # Edit 4 Data ~ Today « » Monthv  Save
Expand all hierarchies 2018
# ©  Project/ Version / Issue Collapse all hierarchies ty Startdate Finish date Durati, Percent d
P Mar 2018 Apr 2018 May 2018 Jun 2018 Jul 2018
> @ ject i x
o ~ [ Procurement Progress line 1/Aug/18 11/0ct/18 52 days 0 4
B procuremet 10/Sep/18 11/0ct/18 24 days 0%
Critical path o |
o B Pre-procure 1/Aug/8 3/Sep/18 24 days 0%
(1] ~ @ Trainusers | & Baseline (Gantt bar narrowed) 27/5ep/18 2/Novi18 27 days
) 4 %
o 3 Prepare (Wt ¢y oy ke issue Editor for Jira (license required) A v gl 204wy %
[1] B Schedule tramng sesst mana Al uwmmor  25/0ct/18 2/Nov/18 7 days 0%
) (1] ~ [ copy of Procurement Michal K. 10%  Minor 1/Aug/18 3/Sep/18 24 days ) y
(1] B3 copy of Procurement ... Michal K.. 0%  Minor 1/Aug8 3/5ep/18 24 days 0% i
Migration to new tool Sebastle. 0%  Minor  12/0ct/18 31/jan/19 80 days 20%
(1] ~ [ Contact Ms Project Users Maria Al.. 100%  Minor 4/Apri18 6/)ul/18 68 days . |
(1] B qQuestionnaire Sebastie. 20%  Minor a/Apr8 4/Mayn8 23 days 0% O
v .
“« —~ [ » “« 1 »
2018
Assignee Units
Mar 2018 Apr 2018 May 2018 Jun 2018 Jul 2018
Michal Kwiatek r
so— |
Sebastien Dellabella X
...-h LB & & N JJ
- Mario Rey Regulez 2
otetd ... i
‘ il v

https//its.cern.ch/jira/secure/WBSGanttMain jspa?filter=BOARD _16¢ y

. Basic resource management and allocation

. Tasks have fixed duration: changing units won’t have an impact on the duration
of the tasks

. Tip: calculate the duration of the tasks taking into account the availability of the
resources and adjust both units and duration if necessary




Baseline

< c ® ® @ hitps://its.cern.chyjira/secure/WBSGanttMain jspa?filter=BOARD_19 e @ @ search v in@o =

@ Getting Started @ Diccionario de la | @ RAL-LCG2 FTS3

@ Gantt: HTCondor o -

QAdd~> @ Delete #Editr ©Viewv N Datav Today « »  Month~ Save
Right-Click : o
Ig t_ IC # (1) Project / Version / Issue Assignee Units Priority S
May 2018 Jun 2018 Jul 2018 Aug 2018 Sep 2018 Oct 2018 Nov 2018 Dec %918
- i
On the Q Migration to Linux |
pand all hierarchies !

. =1 Windows to Linux HPC ... Maria Al. 0% Minor 1< "
prOJ eCt taSk 1.1.1 | Collapse all hierarchies 7 1 cqp Maria Al. 0%  Minor 1€ N Maria Alandes Pradillo E
1-1-1- Add... > 1.1 SLURM integrat... Maria Al... 0% Minor 1< Maria Alandes Pradillo E
el e fesres 1.3 Call for use cases Maria Al... 0% Minor 2S )ruse cases ¥ Wara Alandes Prydillc E
v 1.2 HTCondor integ... Markus ... 0% Minor 2¢ |integration Markus Tapani Jylhankangas |
(1] 1.5 HTCondor early... Maria Al... 0% Minor 2/ 1.5 HTCondor early adopters Maria Alandes Pradillo i
1-1-1-4 (1] 1.4 SLURM early ad... Maria Al... 0% Minor 2/ 1.4 SLURM early adopters Maria Alandes Pradillo E
112 (1) ~ M 2comsoL MariaAl.. 0%  Minor 1€ N Maria Alandes Pradillo :
1-1-2-1 (1] 2.1 SLURM integrat... [l Nils Hoi... 0%  Minor 1S Nils Hoimyr !
1-1-2-3 (1] 2.3 Call for use cases Maria Al. 0% Minor 2/ 2.3 Call for use cases adillo E
1-1-2-2 (1] 2.2 HTCondor integ... Markus ... 0% Minor 2/ 2.2 HTCondor integr Markus Tapani Jylhankangas |
1-1-2-4 o 2.4 SLURM early ad.. Maria Al.. 0% Minor 3/ 2.4SLURM early adopters ~ 'GCG_G———S— \|5ria Alandes Pradillo E
1-1-2-5 o 2.5 HTCondor early... Maria Al. 0% Minor 6/ 2.5 HTCondor early adopters I \aria Alandes Pradillo !
113 o v 3 ANSYS Maria Al. 0% Minor 2¢ 3 ANSYS L g N Maria Alandes iﬁ'adi\lc
1-1-3-1 (1] 3.1 Install SWin Lin... Maria Al. 0% Minor 2¢ SWin Linux -J Maria Alandes Pradillo E
1-1-3-2 (1] 3.2 RSM installatio... Maria Al. 0% Minor 4/ d configuration J aria Alandes Pradilio B
1135 o 3.5 Call for use cases Maria Al. 0% Minor 15 | 3.5 Call for use cases ™ Maria Alandes Pradillo E
1133 (1] 3.3 SLURM integrat.. Markus ... 0% Minor 6/ 3.3 SLURM ints b Markus Tapani Jylhankangas !
1134 (1] 3.4 HTCondor integ... Markus ... 0% Minor 27 3.4 HTCondor m[egk Markus Tapani Jylhankangas E
141-3-6 o 3.6 Implement earl... Maria Al.. 0%  Minor 27 3.6 Implement early adopters _J Maria Alandes Pradillo |
1137 (1] 3.7 Debug early ad.. Maria Al.. 0%  Minor 8 3.7 Debug early adopters ~ T |, A\a'wde:, Pradillo
1-1-4 v » 4 HFSS Maria Al. 0% Minor 8/ 4 HFSS | 4 T

https://its.cern.ch/jira/secure/WBSGanttMain,jspa?filter=BOARD_19# | 3 < 1 | )




Baseline

<« C @

@ Getting Started @) Diccionario de la leng... @ RAL-LCG2 FTS3

vin@o =

) @ httpsy/its.cem.chyjira/secure

Create

@ Gantt: HTCondor o~
QAdd~ © # Edit~ @ M Data v Today « » Monthv  Save
2018
# @  Project/ Version / Issue Assignee Units Priority S
May 2018 Jun 2018 Jul 2018 Aug 2018 Sep 2018 Oct 2018 Nov 2018 Dec 2918
1 » @ HPC Migration to Linux
1 7] ~ [ 0 Windows to Linux HPC ... Maria Al. 0%  Minor 1 :
(1] -~ Mot Maria Al 0%  Minor 1€ |
1 o 1.1 SLURM Integrat... Maria Al 0%  Minor 1€
1 (1] 13Callforusecases ® MariaAl. 0%  Minor  2¢ ' ) '
1 [1] 1.2 HTCondor integ. Markus ... 0% Minor 2¢ _‘ TRAET: ;
5 (1] 1.5 HTCondor early... Maria Al. 0% Minor 2 '-_'-
1 4 (1] 1.4 SLURM early ad.. Maria Al.. 0% Minor 2 —— :
1 (1] ~ ™ 2 comsol Maria Al... 0% Minor 1€ o | )
1 1 (1] 2.1 SLURM integrat... [l Nils Hoi... 0% Minor 1€ §
1 L] 23Call foruse cases  ® Maria Al. 0%  Minor 2/ Srw P
1 (1] 2.2 HTCondor integ.. Markus ... 0%  Minor 2/ ':_-
11-2:4 (1] 24SLURM earlyad... ¥ MariaAl.. 0%  Minor 3/ A —8— i
2 (1] 2.5 HTCondor early.. Maria Al 0%  Minor 6/ A :
o ~ M 3ansys Maria Al. 0%  Minor  2€ P |
1-13 o 3.1 Install SW in Lin.. Maria AL 0%  Minor # 2¢ -
1 (1] 3.2 RSM installatio... Maria Al... 0% Minor 4/ —_ A Pra :
1135 o 3.5 Call for use cases @ Maria Al 0%  Minor 1t - J
(1] 3.3 SLURM integrat... Markus ... 0%  Minor 6/ E—
A (1] 3.4 HTCondor integ. Markus ... 0% Minor 27 "'_ '
3 (1] 3.6 Implement earl... Maria Al 0%  Minor 27 y t _' A
1137 (1] 3.7 Debug early ad.. Maria Al... 0%  Minor 8/ S X
1 v » & anFss Maria Al... 0%  Minor 8/ F *
‘ i v [ m 5

The grey bars show the baseline: your original plan
Enable/Disable it in the View Menu




Progress

+ Warnings
« Tasks about to start

« Task not finished by the end date
- | Percent done

Today « » Day =

QAdd~ | @Deleter #LEdit ©View~w TN Data~
Mon 10 Dec 2018 Mon 17 Dec 2018 Mon 24 Dec 2018 Mc

# @ | Project/Version /Issue Assignee Units Priority Startdate T | Finish date Durati... Percent done

M|T W/ T F|S S M|T W T F S §M
1 ~ @ Gantt Test 1 0%
1-1 (1] - Evaluation Phase Maria Al... 100% Minor 17/Dec/18 18/Jan/19 25 days 12% Evaluation Ph
1-1-1 (1] [ create list of tools Maria Al.. 60%  Minor  17/Dec/18 4fjan/19 15 days 20% Create list of too\s e ——
1-1-2 B3 shortlist candidate tools Maria Al... 100% Minor 7/lan/19 18/Jan/19 10 days 0% Shortlist ¢

Current date: see whether you are late or ahead of schedule




Progress

- Criteria to update progress needs to be defined

Frequency
Every week?
Every project review?

Who?

- Any user?
Project leader?
- Accuracy depends on the criticality of this
iInformation

Find a balance between progress reporting
overhead and usefulness for project control and
follow-up




Export (1)

Excel export

- In the Data Menu MIS Project export |
. EXpOI’t tO EXCe| MS Project import

« EXxport to MS Project (xml)

It could be useful for people working with
subcontractors who may use MS Project

« Import from MS Project (see next slides)




Export (I1)

- Print Button suggested by some users
« To print on paper? on PDF?
« Feature request for printing: WGC-855

- Several Workarounds:

« EXxport to Excel and then print from PDF (From
the Data Menu)

- Feature request to display task names in the Gantt
Chart: WGC-859

A B 1 K L M N O [P QRS TUVWX Y ZAAEACALAEAFACALA| AJAKALANARACAFACARASATALANAVAXAYAZB/BEBCBLBEBFBCBL B BIBKBLBNBIB(B
1 Baseline Plan 20181210 | 0181217 | 20181294 | 20131231 | 20190107 | 20150112 | |
# Alert Project / Version / Ticket Key Type | Assignee | Priority | Status Start Finish Start Finish Days | % Done {Due Date i i i
1 Gantt Test 1 Project 0%
1-1 C‘ Evaluation Phase GANTT1-1 Task |Maria Alai  Minor To Do 12/17 1/18 25d 0%
1-1-1 C‘ Create list of tools GANTT1-2 | Sub-task {Maria Alaf Minor To Do 12/17 1/4 15d 0% \‘
112 Shortlist candidate tools GANTTL-3 | Sub-task [Maria Alal_Minor | ToDo 7 | 1pe | 10d | 0% e— ——
Baswina Plan 2013-22-10 | 3033-12-17 | DOiE-13-14 | J01E-12-31 | 20155407 | 2019-31.- Li- |
a Aurl Fropet { virsion [ Tichin Baw Types | Adsignes] Pricwily | Stabes | Start | Fiish | Start | Fisish | Days | % Dene | Due Oate]by Tiva 1) F S]S]00 TW0 ) F) S S[0g T T) F) 5] S[04 Tjag 1] 1
1 Gami Tirid 1 Prjict [,
1-1 ] Eva lusatioon Phasi GARTTL-1 Task | Masia Al Misar Ta Da 11T if1a 25d .
i-1-1 ) Craate kst of 1oak GARTTL-2 | Sub-tack | Maria Alad  Miser Ta Da 1317 14 15 d e -
‘ i-1-2 Shorbnl casdidale tosls GARTTL-3 | Sub-task ; Madia Aliy  Wisor Ta Da 17 ifid iod ¥ EEEEEEEEEEEE




Export (I11)

DHTMLX viewer tool that will be soon
available in CERNbox
Export to MS Project (XML)
Open on CERNbox

Export to PDF, PNG, etc...

Taskname

3 £5 Mew task

0o
0o
0o
0o
(e
(e
(e
(e
(e
O
(e
(e

Mew task
Mew task
Mew task
Mew task
Mew task
Mew task
Mew task
Mew task
Mew task
Mew task
MNew task

MNew task

Starttime
2018-10-14 00:00
2018-10-06 00:00
2018-10-07 00:00
2018-10-08 00:00
2018-10-10 00:00
2018-10-08 00:00
2018-10-07 00:00
2018-10-09 00:00
2018-10-10 00:00
2018-10-11 00:00
2018-10-12 00:00
2018-10-13 00:00
2018-10-05 00:00

End time
2018-10-15 2369
2018-10-08 2359
2018-10-08 2359
2018-10-08 2359
2018-10-10 2359
2018-10-08 2359
2018-10-08 2359
2018-10-09 2359
2018-10-10 2359
2018-10-11 23:59
2018-10-12 2359
2018-10-15 2359
2018-10-08 23:59

Duration

tober

New task

New task

New task

New task

Mew task

. New task

Mew task

Mew task

Mew task

Mew task

Mew task




Importing MS Project files

Make sure to

- Make sure user importing seloct Task
MS Project file has — yPe
« Assignable » permission | e i
- User needs to have a G

Developer role! eeeeeee

- Be patient, the progress bar | oo :
displays status per task!

+ When start or finish dates ]
are not defined

- WGC-858




Other Useful Functionality

Holiday calendar

. https://rssupport.atlassian.net/wiki/spaces/WGCE0909/pages/350
28994 3/Configuring+the+holiday+calendar

Critical Path

- https://rssupport.atlassian.net/wiki/spaces/WGCEQ0909/pages/350290112/Infor
mation+on+analysis+tools+and+functions#Informationonanalysistoolsandfuncti
ons-Viewingthecriticalpath

Progress line

. https://rssupport.atlassian.net/wiki/spaces/WGCE0909/pages/350290112/Infor
mation+on+analysis+tools+and+functions#informationonanalysistoolsandfuncti
ons-Viewingtheproqgress

Adding more columns

. https://rssupport.atlassian.net/wiki/spaces/WGCE0909/pages/350289989/Confi
quring+additional+columns

Complete documentation

. https://rssupport.atlassian.net/wiki/spaces/WGCEQ0909/overview



https://rssupport.atlassian.net/wiki/spaces/WGCE0909/pages/350289943/Configuring+the+holiday+calendar
https://rssupport.atlassian.net/wiki/spaces/WGCE0909/pages/350290112/Information+on+analysis+tools+and+functions#Informationonanalysistoolsandfunctions-Viewingthecriticalpath
https://rssupport.atlassian.net/wiki/spaces/WGCE0909/pages/350290112/Information+on+analysis+tools+and+functions#Informationonanalysistoolsandfunctions-Viewingtheprogress
https://rssupport.atlassian.net/wiki/spaces/WGCE0909/pages/350289989/Configuring+additional+columns
https://rssupport.atlassian.net/wiki/spaces/WGCE0909/overview

JIRA Python API

- Python API
« https://pypi.org/project/jira/
- Gitlab project
« https://gitlab.cern.ch/it-dep-cda/jira-api-utils

« Python libraries and functions to interact and
manipulate JIRA projects

« | would like to offer this through SWAN service
(work Iin progress)



https://pypi.org/project/jira/
https://gitlab.cern.ch/it-dep-cda/jira-api-utils

JIRA REST API

- REST API

« https://cern.service-now.com/service-
portal/article.do?n=KB0002188

< c @ & httpsy/its.cern.ch/jira/rest/api/2/project/PROJECTALT oo @ | Q search v In@ =
J50N  RawData  Headers
Save Copy Filter JSON
expand: "description,lead,url,projectkeys” ~
self: “https://its.cern.ch/jira/rest/api/2/project/2
id: “20511"
key: "PROJECTALT"
description: o
lead:
self: “https://its.cern.ch/firo/rest/opi/2/userusernam
key: *malandes”
name: "malandes"

avatarUrls:

48x48: “https://its.cern.ch/jiro/secure/useravataravatarl

24x24: "https://its.cern.ch/jira/secure/useravatar?size=sma

16x16: //its.cern.ch/jira/secure/useravatar?size=xs
32x32: ://its.cern.ch/jira/secure/useravatarisize=medium&a
displayName: "Maria Alandes Pradillo"
active: true
components:
e:
self: “https://its.cern.ch/jira/rest/api/2/component/26823"
id: *26823"
name: "Documentacion”
isAssigneeTypeValid:  false
issusTypes:
e:
self: “https://its.cern.ch/jira/rest/opi/2/issuetype/4"
id: g
description: "An improvement or enhancement to an existing feature or task."
iconUrl: “https://its.cern.ch/jira/secure/viewavatar?size=xsmal L&avatarId=154188avotorTypesissuetype”
name: Improvement”
subtask: false
avatarld: 15410

self: “https://its.cern.ch/jira/rest/api/2/issuetype/3"
id: 3"

gescription: "A task that needs to be done.”

iconlrl: “https://its.cern.ch/jira/secure/viewavatar?size=xsmal L&avata 418%avatarType=issuetype”



https://cern.service-now.com/service-portal/article.do?n=KB0002188

Keeping up to date

- Egroup jira-gantt-chart-plugin-forum:
-  Community forum:
« https://discourse.web.cern.ch/c/pm-jira-gantt-chart

bl D Latest Project Management i+ X

« c @ @ & https://discourse.web.cem.ch/c/pm-jira-gantt-chart @ @ seanh n =
@ Getting Sterted @ Diccionario de laleng... @ RAL-LCG2 F1S3

Discourse m

@ If you are interested in planning and scheduling using the JIRA Gantt Chart plugin, please join this

community!
IPruiact Management with JIRA Gantt Chart » Top + New Topic
Topic Users Replies ews
¥ About the Project Management with JIRA Gantt Chart category «nev . .

If you are interested in planning and scheduling using the JIRA Gantt Chart plugin, pleass join this community!
JIRA Gantt Chart Plugin Tutoria Q 0 5 36

There are no more Project Management with JIRA Gantt Chart topics. Why not create a topic?.

Mattermost ServiceNow Home



https://discourse.web.cern.ch/c/pm-jira-gantt-chart

Documentation

Get started with JIRA KB

https://cern.service-now.com/service-portal/article.do?n=KB0005904

WBS Gantt Chart for JIRA Demo

https://www.youtube.com/watch?v=nkUbKEave XA



https://cern.service-now.com/service-portal/article.do?n=KB0005904
https://www.youtube.com/watch?v=nkUbKEaveXA

